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he way titration curves are traditionally taught in the
undergraduate curriculum is reviewed, and a more
rational approach is advocated. A spreadsheet is then
used to illustrate the various properties of titration

curves and to fit titration data.

The Traditional Approach
In terms of evolution, the quantitative chemical analysis or
“quant” course is highly conserved. At the end of the 19th
century, Ostwald [1] introduced Arrhenius' ideas of ionic
equilibrium into the analytical curriculum; some 20 years later,
Niels Bjerrum [2] formulated the theory of acid-base titrations
we still teach today.

Of course, modern quant books are different from those of a
century ago: gone is the heavy emphasis on gravimetry, and
much more time is spent on chromatography and spectrometry.
Still ionic equilibria and titrations occupy a central spot in all
current quant textbooks, and their treatment has not really
changed much in the past 80 years. A casual observer might
conclude   that  such   evolutionary  stability   reflects  a   highly

T



2 /  V O L .  1 ,  N O .  3 I S S N  1 4 3 0 - 4 1 7 1

T H E  C H E M I C A L  E D U C A T O R h t t p : / / j o u r n a l s . s p r i n g e r - n y . c o m / c h e d r

©  1 9 9 6  S P R I N G E R - V E R L A G  N E W  Y O R K ,  I N C . S  1 4 3 0 - 4 1 7 1  ( 9 6 )  0 3 0 3 3 - 6

satisfactory state of affairs, already so optimized that it needs no further improvement.
Below we take a closer look at this.

Consider the titration of a single weak monoprotic acid, such as acetic acid, with a single
strong monoprotic base, such as NaOH. Experimentally, a single, continuous titration
curve is obtained. In the standard textbook explanation this curve is usually cut it up into
four separate parts:

(a)  the pH at the beginning of the titration,
(b)  the segment between the beginning and the equivalence point,
(c)  the pH at the equivalence point, and
(d)  the segment past the equivalence point.

Unfortunately, the two curve segments (b) and (d) are only approximate: curve (b) goes
neither through point (a) nor through point (c); likewise, curve (d) never passes through
point (c). It might be argued that they are close approximations, which they usually are,
but then, students are told to take the first derivative of the titration curve in order to
locate the equivalence point. That custom should be based on theory, but how can they
be expected to take the derivative of the theoretical titration curve at the equivalence
point, when neither segment (b) nor (d) ever gets there? How can the students take the
derivative of the single point (c)? They clearly cannot, and a good thing it is, because if
they could actually check the assertion, they would find that, theoretically, the maximum
in the first derivative of an actual titration curve does not coincide with the equivalence
point, as shown by Meites & Goldman [3] as long ago as 1963. So much for our self-
professed emphasis on accuracy.

The Effect of Added Complexity
When polyprotic rather than monoprotic acids and bases are considered, the traditional
approximations rapidly become impractical, as well as increasingly imprecise. In the
titration of H3PO4 with NaOH four discrete points (one at the beginning of the titration,
and one at each of the three equivalence points) are needed, plus four approximate
sections (between these points and beyond the last one). In the acid-base titration of
EDTA, a hexaprotic acid, seven discrete points are needed, plus seven not-quite
connecting sections, for a total of 14 pieces. And what about a buffer mixture, say a
Britton–Robinson buffer, which contains diethylbarbituric acid, citric acid,
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orthophosphoric acid, and boric acid? The traditional, piecemeal approach just is not up
to that task; it doesn't even pretend to know how to tackle mixtures.

It can be argued that we should place more emphasis on modern topics of quantitative
chemical analysis, such as nuclear magnetic resonance and mass spectroscopy. I tend to
agree with that; however, as long as a sizeable fraction of the quant course is spent on
ionic equilibria and on titration curves, as most still do, it might as well be done well.
And, of course, the simpler we make it (especially when that can be done without
distorting the facts), the more time will be left for those other worthwhile topics.

What, specifically, is wrong with the traditional didactic approach to titrations? We try
to write an expression for the pH, or for [H+], as a function of the concentrations and
volumes of the sample and titrant, mainly because that is how the titration curve is
usually obtained. In the titration of a single, strong monoprotic acid, say HCl, with a
single, strong monoprotic base such as NaOH, that can be done; a quadratic equation is
obtained, which can be solved readily.

But, as soon as the problem becomes a bit more complicated, the order of the equation
to be solved shoots up, by one for each pKa:

• for the titration of acetic acid with NaOH we get a cubic,
• for the titration of H3PO4 with NaOH we get a quintic equation,
• for the titration of EDTA with NaOH we get a heptic,
• for the titration of EDTA with Na2CO3 a nonic,

etc. By that time we throw up our hands, and do one of two things: we either give our
students a black box called an equation solver, or we say that the whole thing is too
complicated, so let us approximate it. And that is how we end up with the piecemeal
approximations, cutting the titration curve up into smaller and smaller sections that
become increasingly crude approximations.

A Simple Solution
Fortunately, there is another option, beyond a digital black box approach or the use of
approximations that become unworkable in all but the simplest cases. This option exists
provided that we are willing to pose the problem somewhat differently. All that is
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required is to exchange the coordinates of the problem, not really a very complicated
transformation. When we inquire what is the volume of titrant to be added as a function
of pH (rather than what is the pH for a given titrant volume), the mathematics remain
perfectly tractable, that is, we do not run into equations that cannot be solved on a
pocket calculator. All we need to do is to consider titrant volume as a function of [H+] or
pH, rather than the other way around. And that only for the purpose of the calculation;
the data can still be plotted any way we like, because the final graph doesn’t show
whether the titrant volume  was calculated as a function of pH, or the other way around.

When the titrant volume is calculated as a function of [H+], the mathematics are quite
straightforward. Moreover, they are only marginally more complex for complicated
systems, such as mixtures of polyprotic acids, than for a simple monoprotic acid.
Without making any assumptions beyond the mass action law and the conservation of
mass and charge, we obtain for the titration of any single acid with any single base a
general equation of the form

V

V

F C

F C
b

a

a a

b b

= −
+

∆
∆ (1)

where Va is the volume of the acid (the sample) originally placed in the titration vessel,
while Vb is the volume of the base (the titrant) added to the titration vessel. The
corresponding concentrations are Ca for the acid in the sample, and Cb for the base in the
buret, that is, both counted at the onset of the titration and therefore constants. Of these
four parameters, only Vb will change during the titration. Equation 1 takes into account
the mutual dilution of sample and titrant upon their mixing in the titration vessel. The
symbol ∆ (delta) is shorthand for [H+] – [OH–]. Most of the detail hides in the functions
Fa and Fb, which contain the usual concentration fractions, α, with suitable integer
coefficients. These functions can be written explicitly in terms of [H+] and of the various
equilibrium constants; a few examples are given in Tables 1 through 4, while further
details can be found in references [4–6].

When a mixture is considered, as in a “universal” buffer mixture (or, for that matter, in
the titration of a single acid or base in the presence of an acid-base indicator), we obtain
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TABLE 1.  Examples of the function Fa for a general monoprotic, diprotic, and
triprotic acid respectively, here represented by the examples of acetic, oxalic,
and orthophosphoric acid. The integers in these expressions reflect to the fact

that, e.g., H3PO4 loses two protons to form HPO 4
2- , and three to generate PO 4

3- .

Acid: General expression for Fa
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where the summation is over all acids in the sample. In general, for the titration of any
mixture of any acids with any mixture of any bases, we find an equation of the form
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Furthermore, for the reverse problem, the titration of bases with acids, the equation
merely needs to be turned around, again for any mixtures of sample (now labeled b) and
titrant (now a):
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TABLE 2.  Examples of the function Fb for a general monoprotic, diprotic, and
triprotic base respectively, here represented by the examples of ammonia,
carbonate, and orthophosphate. The integers in these expressions reflect to the

fact that, for example, PO 4
3−  gains two protons to form H2PO 4

− , and three to
generate H3PO4.

Base: General expression for Fb
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The reader will recognize that the product Ca Fa counts the moles of protons removed
from an acid; likewise FbCb counts the moles of protons added to a base. It really is that
simple!

So here is given a simple yet completely general expression for the acid-base titration of
any acid or base, or for any mixture thereof, no matter how many species or equilibrium
constants are involved. Why belabor this point here? Because any didactically useful
comparison of experimental data with theory requires that the theory is at least as good
as the  data. In  this respect,  computers are  rather unforgiving,  especially  spreadsheets
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TABLE 3.  Simplification of the expressions in Table 1 and 2 for strong acids
and bases, in which case the relevant value of α is 1.

Acid or base: Explicit expression for Fa
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with their standard use of “double precision” arithmetic. Therefore, our first item of
business had to be to put our theoretical house in order, so that we are now ready to
proceed with a comparison between theory and experiment. Why would anyone want to
compare high-quality experimental data with a crude and often unworkable
approximation of a theory, when a much more satisfactory theory is both readily
available and easily applicable?

A Specific Example: The Titration of H 3PO4 With NaOH
We now illustrate how the equations displayed above can be used in teaching
quantitative analysis. To this end a modern spreadsheet will be used for the following
reasons: (1) the spreadsheet serves as a simple calculational aid that relieves the student
of the tedium of mindlessly repetitive numerical calculations, (2) the spreadsheet
provides convenient graphing facilities, making it easy to visualize the results obtained,
and (3) modern spreadsheets facilitate the use of sophisticated data analysis tools.
Specifically, Excel version 7.0 for Windows 95 is used.

Open a spreadsheet, and in column A (i.e., in cells A1 through A6) enter the following
labels for the input parameters: Ka1=, Ka2=, Ka3=, Kw=, Ca=, and Cb=. In column B
enter corresponding numerical values, such as 7.1E-3 (computer shorthand for 7.1×10-3),
6.3E-8,  7.1E-13,  1E-14, 0.1,  and 0.1  respectively.  As a  help in  writing and  trouble-
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TABLE 4.  Examples of the functions Fa and Fb for several acid salts, that is,
salts containing dissociable hydrogen ions.

Acid salt: General expression for and  F Fa b
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shooting the theoretical expressions, assign these numerical values their corresponding
names. (To do this in Excel 7, highlight the cell that should be named, then go to the
name box in the formula bar, that is, the white space on the bar just above the column
heading A. In that name box, click on the regular cell address, then replace it by the
chosen name simply by typing and entering the latter. Subsequently, the cell can simply
be referred by its given name. Note that this only works for absolute addresses, that is,
for cells otherwise addressed with two dollar signs, as in $B$3. An alphabetized list of
all assigned names is available for inspection by clicking on the down arrow to the
immediate right of the name box.)

In cells A13 through E13 enter the column headings pH, H, OH, F, and Vb/Va
respectively, and once more enter the label pH in cell I13. In row 15 start the actual
calculations. (We reserve most of the space above row 13 for on-the-spreadsheet
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graphs.) In cell A15 deposit the number 0, in cell A16 the instruction =A15+0.1, then
copy this instruction down to cell A155 to cover the usual pH range from 0 to 14. In cell
B15 deposit the formula =10^-A15, in cell C15 the instruction =Kw/B15, in D15 the
equation for Fa in Table 1 for phosphoric acid, that is, =(B15^2*Ka1+2*B15*Ka1*Ka2
+3*Ka1*Ka2*Ka3)/(B15^3+B15^2*Ka1+B15*Ka1*Ka2+Ka1*Ka2*Ka3), and in cell
E15 the expression for Vb/Va from equation (1), viz. =(D15*Ca-B15+C15)/(Cb+B15-
C15). Copy cells B15:E15, and paste them in block B16: E155. Now copy the pH
values from A15:A155 to I15:I155. (We repeat the pH values in column I in order to
accommodate the annoying requirement of Excel that the leftmost column in an array
must be the x-axis in an xy plot. Moreover, we leave three columns empty in anticipation
of their future use.) Finally, make an xy plot of the theoretical titration curve on the
spreadsheet (in block D1:F12), that is, pH (in block I15:I155) versus Vb/Va (in
E15:E155), using the data in the first column (E15:E155) for the x-axis. Give the graph a
title, such as Titration Curve, and label its axes. Restrict the ranges shown to 0≤Vb/Va≤0
and 0≤pH≤14.

The theoretical curve has some features that require an explanation. View the first few
cells of E15:E155; the spreadsheet can calculate negative values for Vb/Va at its lowest
pH values. This is a consequence of the  use of parameters that prevent reaching the
specified pH value of 0, because it is clearly impossible to obtain pH = 0 with any (weak
or strong) acid of concentration 0.1 M. The negative values indicate that, under such
conditions, one would have to add a negative amount of strong base (withdrawing a
strong base is mathematically equivalent to adding a strong acid) in order to reach zero
pH. You can easily verify that this artifact indeed disappears when the numerical values
for Ca and/or Ka1 are adjusted so that pH = 0 can be realized. Likewise, at the highest
pH values, the spreadsheet calculates some physically unreasonable results, because it is
clearly impossible to reach pH 14 by adding 0.1 M strong base to an acid: the best one
can hope for is to approach pH 13 when Vb » Va. Again, this effect will disappear when
Cb is taken to be sufficiently large. Once we understand that these artifacts come from
our insistence on  using some physically unattainable pH values at the beginning and end
of the conventional pH scale, they should no longer bother us. At any rate, we have
made them largely invisible in the graph by limiting the Vb/Va range shown.
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Fitting Simulated Data
Another way to display the same data is the progress curve, which is simply a titration
curve with the Vb/Va and pH axes interchanged. This format is needed because the theory
provides Vb/Va as a function of [H+], but not the other way around. Create such a
progress curve by plotting (in block G1:I12) the volume ratio Vb/Va (in E15:E155) versus
the pH (in A15:A155). With the progress curve we can now illustrate the method of
steepest descent. This method seeks to maximize the fit between theory and experiment
by minimizing some function characterizing their difference. Here the sum of the squares
of their differences are minimized.

First a simulated data set is made by copying a set of data from the theoretical curve in
E15:E155 and pasting it into F15 with the command sequence Edit⇒Paste
Special⇒Values⇒OK. This will give us a data set (to be labeled testset in cell F13) that
is, as it were, frozen in time. For example, change the value of Ca in B5 to 0.05; as a
consequence, the data in column E will change, but those in column F will not. This is
most readily seen when we insert the “frozen” data set into the plot of the progress
curve: activate that graph by clicking on it, and again double clicking, which should
change the edge around the graph to a hatched one. Then click on Insert⇒New Data. A
New Data dialog box appears, in which you type F15:F155, then click on OK. Presto!

In order to let the spreadsheet find the concentration Ca of the acid in the frozen data set,
we first compute in cell G15 the square of the difference between it and the model, that
is, =(E15-F15)^2, and copy this down to row 155. Label this column difsq in cell G13.
In cell A11 deposit the label sumdifsq=, and in B11 the instruction =SUM(G15:G155).
Now change the value of Ca in cell B5, and invoke the Solver routine (which should
have been installed using Tools⇒Add-Ins⇒Solver Add-In) with the command sequence
Tools⇒ Solver, and in the resulting dialog box specify Set Target Cell as B11, Equal to
Min, By Changing Cells B5. From the Options menu select Show Iteration Results, then
return with an OK to the main dialog box, and click on Solve. The spreadsheet will now
vary the value of Ca in cell B5; when this results in a decrease in the sum of squares in
B11 it will keep changing B5 in that direction, otherwise it will reverse its course.
Because the spreadsheet was instructed to show some of its intermediate results, you can
actually see this trial-and-error method at work in the graph as well as in cells B5 and
B11 (and you must keep it going by answering Continue every time the Show Trial
Solution box appears). It usually takes only a few trials to home in on the correct
answer.
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This is, of course, a rather sterile example, because the comparison is between two
theoretical curves, without anything resembling experimental uncertainty. The data set
simulating experimental data can be made somewhat more realistic by adding to it some
(artificial) noise. For this we will use the Analysis Toolpak, which should have been pre-
loaded. Click on Tools, then on Data Analysis. In the resulting dialog box, select the
Random Number Generation by double clicking on it. (You may have to scroll down in
the box to find it, because the R of Random has a low standing in the alphabet.) In the
subsequent dialog box select the Distribution as “Normal” (i.e., Gaussian), and as
Parameters Mean = 0 and Standard Deviation = 1; in the Output options, click on the
Output Range, then specify it as H15:H155, and close the dialog box with OK. In cell
H13 place the label noise, and in cell A7 the label NA =, then specify a numerical value
for the noise amplitude in B7 (e.g., 0.01), and name it NA. Now go to E15, add to its
instruction the term +NA*H15, and copy this modified instruction down to cell E155.
By changing the numerical value of NA in cell B7 we control the amount of noise added
to the calculated curve. Update the testset in F15:F155 to include noise (again using
Edit⇒Paste Special⇒Values⇒OK), then reset NA to zero, because we use NA = 0 for
the theoretical curve, except when it is used to generate a set of data for column F.

There is another refinement that may need to be introduced. The numbers computed for
the physically not realizable pH values sometimes dominate the sum of squares, even
though they have no physical meaning. We have already kept them out of the graphs,
and we can also keep them from being counted in the Solver routine by modifying the
instruction in cell G15 to read =IF(F15<0,0,IF(F15>4,0,(E15-F15)^2)), which is
spreadsheet shorthand for “if F15 < 0, make G15 equal to 0; otherwise, if F15 > 4, set
G15 equal to 0; otherwise (i.e., only for 0 < F15 < 4) make G15 equal to (E15-F15)^2.”
Copy this instruction down to row 155. Now only physically significant data will be
used.

With these additions, experiment with various Ca values, and with the effect of noise.
Verify that the value of Ca can be recovered only approximately when the noise
amplitude becomes too large.

Also vary other parameters, such as the values of the various Ka’s in B1, B2, or B3, and
see if they can be recovered with the Solver. (Don’t forget to change the variable in the
Solver Parameters dialog box under By Changing Cells.) Sometimes this may not work,
because the required adjustments may be too small, especially for Ka3. To increase the
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chances of success, enter the corresponding pK values in C1:C4, that is, 2.15, 7.20,
12.15, and 14, then make B1:B4 refer to these (e.g., deposit =10^-C1 in cell B1), and
select one of the cells in column C (rather than in B) in Set Target Cells.

It is possible to vary several of these parameters simultaneously, and then let the Solver
recover them. Obviously, this will be more successful for input variables that have a
significant effect on the curve, such as Ca, than for parameters that have a more marginal
effect, such as Ka3.

Fitting Experimental Data
The tools are now in place to compare truly experimental data with the theory. What
follows are the directions given to students to perform such a comparison.

First, do a rough titration of an aliquot of orthophosphoric acid with NaOH, and
record your observations. Use this to locate the approximate positions of the
equivalence points. Then, carefully titrate a second aliquot, making sure to use
small titrant additions in regions where the pH changes strongly, and recording
the volume and pH readings in your notebook. Do not rush the titration, but
allow sufficient time after addition of a small volume of titrant to allow for its
complete mixing with the sample, as reflected in a stable pH reading. By
making the buret tip touch the inside wall of the titration vessel, remove any
partial drops that otherwise might be left hanging there (and that otherwise
would count as delivered by reading the buret, even though they have not yet
reached the sample).

Starting at row 15, now enter the data from your notebook into the
spreadsheet: Cb (in M, i.e., in moles per liter) in cell B6, pH readings in column
A starting in row 15, and the corresponding volume readings (in L, not in mL)
in column F. You may have to adjust the column length to that of your
experimental data set, and modify the range of summation in cell B11
accordingly. (The nested IF statements in column G are innocuous, and can
be left in place.) Column E will now automatically compute the theoretical
curve for the same pH values you used, and the Solver can be used to find the
sample concentration Ca.

Refinements
There are several assumptions we have made so far that can now be checked and, if
necessary, refined. The first of these is that the titrant is simply NaOH. Often, sodium
hydroxide solutions contain noticeable concentrations of carbonate, accumulated by
reaction with CO2 from the air. The conversion of sodium hydroxide into carbonate will
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mostly show in the experimental data as a lowering of the titrant volume Vb required to
reach the first equivalence point (because carbonate accepts only one proton at a pH
below its pKa1 of about 6.35) and as a change in the shape of the titration and progress
curves beyond the second equivalence point, while not affecting the value of Vb at the
second equivalence point.

In this case there are two options: either remove the carbonate from the titrant, or
include it in the simulation. While the former is, in general, the more sensible approach,
the latter is pedagogically of interest. Use equation (3) and the expression for Fb in Table
2, together with literature values for the Ka’s of carbonic acid. Then use Solver to adjust
both Ca and the two Cb’s (one for NaOH, the other for Na2CO3, their sum being equal to
the original sodium hydroxide concentration), either separately or simultaneously.

The second assumption is of a somewhat different nature, because it does not involve
the purity of the reagents, but the validity of the theoretical model. Until now it has been
assumed that the pKa values from the literature are true constants and can be taken, as
such, from the literature. Although they are in principle indeed constants, when used in
practice they are only approximately so, because the literature values are usually
extrapolated carefully to make them constant, the extrapolation rendering them
insensitive to ion-ion interactions. We can use the Debye–Hückel theory or its
extensions to correct for the presence of such interactions. Here we will illustrate this by
using a particular extension, the Davies equation, which allows us to make such activity
corrections without introducing any adjustable parameters.

Activity corrections to titration curves consist of two parts: (a) the Ka values need to be
modified, and (b) the measured pH needs to be corrected. At the level of the Davies
equation, both corrections depend only on the ionic strength,

I z c= ∑1

2
2

(5)

a concentration parameter that varies during the titration. (In this equation, z is the ionic
valency, and c the ionic concentration.) We must therefore calculate the ionic strength,
then correct the theoretical prediction before comparing it with the experimental data.
Below is shown how this can be done. A faster, empirical (but more approximate)
approach is to neglect the effect of interionic interactions on the measured pH, and
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merely to replace the Ka’s by their “formal” values. In the present case this is most
readily done by considering the Ka’s as adjustable parameters rather than as constants.
As we have already seen, the Solver is well-suited to find the equilibrium constants of
the experimental curve, and to adjust the theoretical curve accordingly. Below is
illustrated the somewhat more involved correction based on the Davies equation,

( )f
I I I= − + −

10
0 5 1 0 3. { / . }

(6)

and

f fi
zi=
2

(7)

where fi is the activity coefficient, a parameter that can be used to correct ionic
concentrations and equilibrium constants for the effects of ion-ion interactions.

First, calculate (in column J) the ionic strength I of the solution being titrated, as a
function of the progress of the titration, assuming the absence of ion-ion interactions.
Then, use these values for I to compute (in column K) the corresponding values of f.
Finally, calculate the function Fa using corrected  values for the equilibrium constants:
Ka1=Ka1

t/f 2, Ka2=Ka2
t/f 4, Ka3=Ka3

t/f 6 and Kw=Kw
t/f 2, where the superscript t denotes the

tabulated (or thermodynamic) value. Finally, in going from pH in column A to [H+] in
column B, use [H+] = 10-pH/f. Next calculate the ionic strength, and repeat the cycle, until
further iteration only causes negligible changes; in practice, the first step almost always
suffices. All of these computations are readily performed on a spreadsheet (it takes much
longer to explain their origin than to implement them) and, in the end, the effort is barely
worth it, because the resulting shifts in the titration and progress curves of
orthophosphoric acid are relatively minor [6]. But that is a conclusion we may want the
students to reach by themselves, something the spreadsheet enables them to do.

There are many possible side projects: the students can compute the first derivative of
the titration curve (using either simple differences or a more sophisticated method such
as a sliding polynomial using Savitzky–Golay coefficients); they can make Gran and/or
Schwartz plots as aids in determining the precise locations of the equivalence points;
they can experiment with these to evaluate which of these methods is more easily
defeated by the presence of noise, and which are relatively robust. But then the project
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easily becomes fairly large, not because it is difficult to do on a spreadsheet (which it
isn’t) but because each of these methods requires a detailed explanation.

Discussion
There is nothing wrong with using approximations in science, as long as they are
necessary, that is, when the more precise theory is either unavailable or is far too
complicated to consider. In the case of titrations, however, neither is true: a complete
theory is available, and (except perhaps for the simplest possible examples) is actually
less complicated and much more straightforward than the approximations. Consequently,
it allows us to describe  more general cases, and in a much more uniform framework,
than can be encompassed with the approximate model. Given these conditions, not only
is there no need to use an approximate theory, but there is no justification for doing so.
Approximations are often a necessary evil; in the present context, they are an
unnecessary evil.

The above is not a new theoretical approach: for the titration of single components it
was already implicit in Butler's 1964 book [7], explicit in Fleck's 1966 book [8], and
strongly advocated by Waser [9] in 1967. Waser also discussed mixtures, and Willis
[10] gave specific formulas and examples. Why was it ignored for so long in most quant
textbooks? Perhaps because, in the sixties, we still did our calculations on sliderules;
only much later did pocket calculators come into wide-spread use. But now, in 1996,
many of our students already have their own computers. What are we waiting for?

This approach is not limited to just acid-base titrations: it works for any titration:
complexometric, precipitation, redox, etc. Again, Butler [7] already showed this.
Sometimes, as with redox titrations, the resulting equations are even simpler [11] than
those shown here, because we always neglect the redox properties of the solvent, which
are controlled by kinetics rather than by equilibrium processes. That is equivalent to
deleting the terms in ∆ in equations 1 through 4.

Titrations are only the most complicated part of the traditional treatment of ionic
equilibria. How about the usual pH problems? Here, again, it is possible to use already
available methods to achieve a significant reduction of effort. By using stick diagrams,
which are nothing but slightly simplified logarithmic concentration diagrams, we can
gain a quick overview of ionic equilibria no matter how complicated they are. Then we
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can simply see which approximations are appropriate, and make a rational choice —
instead of having to rely on that rather ethereal stuff called chemical intuition with which
few seem to be endowed. Again, spreadsheets can be very helpful in showing where
stick diagrams come from.

One might ask whether using a spreadsheet is really different from using a digital black
box, such as an equation solver. The answer is that it is indeed quite different, because a
spreadsheet is a totally transparent box, in which students can follow every step in
detail, and don’t have to relinquish control over the process. All the spreadsheet does is
the boring work of straightforward but repetitive calculation and of displaying the data in
graphical form. The only black box in the present example is the method of steepest
descent, and, even there, the display of intermediate results shows the principle of the
method, though not its inner workings.

Again, many others have used spreadsheets in quantitative analysis: they were already
advocated and used explicitly in books by Guenther [12], Adley [13], Freiser [14], and
myself [15], and have since found their way into some general quant textbooks. In this
paper I have  merely integrated these various approaches.

Does this work in the classroom? Over the past seven years I have used and fine-tuned
this approach at Georgetown, and in my experience it works well. In fact, as
spreadsheets become more sophisticated, it becomes better all the time.

A common concern of science teachers is to make their students “computer-literate.” For
this the quant course is a natural vehicle because of its emphasis on quantitative
analysis. Moreover, the approach outlined above works best when the students have
easy access to graphs. In both of these respects, spreadsheets fit the bill: they are easy to
learn, they can get the students past their fear of computation, they can be used to make
virtually all the calculations an undergraduate chemistry student will need, and they are
superb graph makers. Moreover, we might as well exploit the fact that many students
already have their own computers, and teach them to use these as more than just
glorified typewriters.

Conclusion
The primary take-home message of this communication is that the approach advocated
here, based on simple yet exact theory combined with the use of modern visualization
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and data analysis tools, empowers the students: they can verify what we teach them, and
even anticipate the experimental problems they may encounter. At the same time, the
approach illustrates how science works. We start from a very small set of initial
assumptions: the mass action law and the laws of conservation of mass and charge. From
these we can readily derive relations such as equations 1 through 4. Combining those
with some assumed equilibrium parameters leads directly to a theoretical titration curve.
We then use this equation to determine the (initially unknown) concentration of an acid
(or base) in a sample, the primary purpose of an analytical titration. We also showed
how the same method can be used to determine the equilibrium parameters for a given
acid (or base) from the experimental data, at which point it becomes clear that the
equilibrium constants are themselves experimentally accessible and verifyable quantities.
Finally, we reconsider the initial assumptions: there may be impurities in the titrant, and
the mass action law may need to be corrected for activity effects. Both of these can be
taken into account in the theory. At this point the student can see the entire picture of the
scientific approach: (a) a simple set of initial assumptions leads to a precise prediction,
(b) comparison with experiment yields approximate agreement with the prediction,
thereby validating the initial assumptions as useful working hypotheses, (c) more
detailed inspection may show some minor discrepancies, which (d) may then require
refinement of the experiment and/or of the original assumptions.
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